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Meeting venue
Meetings are held on
the last Wednesday of
each month (except
December) beginning
at 7:30pm, at Waimairi
School Hall at the end
of Tillman Avenue, off
Bligh’s Road.
Drinks and snacks are
available while we all
calm down after the
excitement of the meeting.
Some members carpool to get to meetings. If you don’t have a car and
find it difficult to get to meetings, please contact a committee member to
arrange transport. Usually there is someone living near you who can
offer a lift.

Meeting programme
Wednesday 29th May 2013

7:30 Monthly Meeting
• Welcome and News
• MacBasics
• Printers by Graham Kennett, NZ Toner Office Supplies Ltd
• Information Exchange
• Supper

Come along and share your passion
for Apple products. Learn about the
latest technology, and enhance your
skills. And meet with old and new
friends over supper. Also remember
to try your luck with the evening’s
raffle. Visitors welcome.
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Submitting your article
Electronic submissions are preferred (to save wear and tear on my
fingers). Just choose whatever format suits and send it to:
editor@appleusers.co.nz
One page is roughly 450 words. Most article are less than 4 pages, but
longer articles may be accepted if of particular interest or relevance.
Please ask in advance if you are planning a longer article.
Please write clearly; short sentences are recommended to help you do
this. Use a spell-checker. If you are quoting some other article, please
include an acknowledgment of your source.
Pictures can help explain your article, so by all means include one (or
more) if appropriate. The format is not important - jpeg, tiff and gif are
all fine, but try to provide a high quality image (300 dpi) if possible.
For screen shots, you can use the build-in Apple functions Apple-Shift-3
or Apple-Shift-4, or a utility such as Snapz Pro, available from:
http://www.macdownload.com.

Next Deadline: 12 June 2013
Prez sez
Noel Strack
I have just returned from a whirlwind visit to two
extremes - a visit to a newly graduated brain
researcher (25 year old) and a 95 year old writer
who has just published his latest book on the
emergence of consciousness - defining the difference
of man and animals. He has also published and is
recognized as an historical expert on art and
mathematics - “So what?” you may say nothing really except they are both also expert
on our favourite computers and in their spare
time play games on their machines - the 25
year old, war games with friends all over the world, and the older one scrabble with his grandchildren, who are also all over the world.
Their mental activity on the keyboards overwhelmed me; all I seem to do
is play with Photos & Music.
I trust you are all of the busy type.
Come along to our next meeting and hear more about printing off your
masterpiece
Good Luck
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BlueBulb LED Lightbulb
“After nearly nine months of research and development, bluetooth
lighting startup BlueBulb is finally ready to ship a small batch of initial
units to customers in a bid to bring remotely-controlled, multi-color
lighting into the mainstream,” Mikey Campbell reports for AppleInsider.
“While mass production of BlueBulb may be months away, AppleInsider
was able to spend some time with one of the first units to roll off the
assembly line.”
Not quite satisfied with plain white light, BlueBulb uses a unified RGB
+White LED array, allowing for a wide variety of color outputs — one
million in all according to founder and CEO Peter Lakits. Color changing
is a neat trick, but the real draw for many BlueBulb users is the promise
of a simple to setup iOS-controlled light. Lakits noted that the iPhone is
especially well suited for the task, as the handset rarely leaves a user’s
side… Notably, BlueBulb carries a white LED which, when combined
with the light from supporting RGB LEDs, can produce varying color
temperatures to suit a user’s needs. ‘You can soften or harden the
whiteness,’ Lakits said, referring to the gradients of white light offered by
BlueBulb. ‘Sometimes I want a warmer light to relax, or maybe more
blue for reading.’
Unlike the Philips hue light bulb, which is controlled over Wi-Fi via a
wireless gateway, BlueBulb uses energy-sipping Bluetooth 4.0
technology to make a direct connection with an Apple iOS device. For
now, support is limited to the iPhone 4S, iPhone 5, third and fourthgeneration iPads, and the iPad mini.
Just think of the fun you, and your iPhone, could have at a party - along
with everyone else .... And how long before someone writes an App random colour, or synchronized with your music?
It’s not whether you win or lose,
but how you place the blame.

Learn from your parents’ mistake
- use birth control.

You are not drunk if you can lie
on the floor without holding on.

Money isn’t everything,
but it sure keeps the kids in touch.

If at first you don’t succeed,
skydiving is not for you.

The original point and click interface
- a Smith & Wesson.

We have enough “youth”
How about a fountain of “smart”?

We are born naked, wet and hungry.
Then things get worse.

A Fool and his money
can throw one heck of a party.

Reality is only an illusion
that occurs due to lack of alcohol.

When blondes have more fun,
do they know it?

Ninety-nine percent of all lawyers
give the rest a bad name.
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Take Control - Dropbox
Adam & Tonya Engst
Joe Kissell's "Take Control of Dropbox" helps you learn and teach
Dropbox
Here at Take Control, we've long been huge fans of the Dropbox filesharing service, relying on it every day to collaborate on manuscripts
with our authors and editors. Now we're pleased to share our expertise
with you in the form of Joe Kissell's latest ebook, "Take Control of
Dropbox." The book normally costs $10, but the 30% MUG discount
drops that to $7.
Whether you're already among the millions of people who sync and share
files with Dropbox or you plan to join their ranks soon, Joe Kissell has
the real-world advice you need to go beyond the basics. He shares the
best practices for using Dropbox effectively and securely on your own or
with a group, explains how to avoid common mistakes and irreversible
settings, describes what's involved with mobile devices and Dropboxsavvy apps, and tips you off to unusual uses of Dropbox.
Did you know you could use Dropbox to control your Mac, publish a
blog, automate Web activities, sync with other cloud services, and even
publish a book like this one?
Perhaps you do know all that, but since Dropbox shines brightest when
sharing files with friends and colleagues, we've included a "Teach This
Book" chapter with links to a downloadable single-page PDF handout
and an 18-slide PDF presentation that you can employ to help your
collaborators use Dropbox correctly (and thus make your life easier).
Other useful advice in "Take Control of Dropbox" includes how to:
* Recover an accidentally deleted or revised file. You'll find help with a
few non-obvious controls and a discussion of the Packrat option for
Dropbox Pro users.
* Work with photos and videos in your Dropbox folder and learn how to
share collections with Dropbox's new photo album feature.
* Use Dropbox to store and automatically sync data used by Dropboxsavvy apps on all of your devices, whether they're running Mac OS X,
iOS, Android, Windows, or Linux. You'll get a better idea of what's going
on behind the scenes and how to manage app authorizations.
* Check a few important account-related details to make sure you're set
up optimally. These include security settings and methods of getting more
storage space.
Be sure to check out Joe's short intro video on the book's page!
Two final notes, since we like to give you peeks behind the curtain here
at Take Control. First, you'll notice that "Take Control of Dropbox" sports
page 6 Applebyte

an elegant new cover design and logo, both created especially for us.
You'll be seeing more of these covers in the future, in a variety of colors.
Second, if you like reading on a Kindle, the Mobipocket version of this
book will be available in your Take Control library immediately after
you purchase, thanks to a new (Dropbox-based!) publishing system that
we used. The book looks great on a Kindle Fire or Paperwhite and is
entirely acceptable on older and less-capable Kindle models. Between
this new publishing system and a new technique we've developed for our
existing publishing approach, we hope to make Mobipocket files
available simultaneously with other formats going forward.
Thank you for your support of the Take Control series - we couldn't do it
without you!
A ‘Thanks for the Support’ to Adam & Tonya Engst, Take Control
publishers

Smart Glasses
Google may have smart eyeglasses but Budweiser
has smart beer glasses
Budweiser's Buddy Cup creates Facebook friends with a simple clink
Budweiser is trying to make it easier to make friends - Facebook friends when you're drinking beer.
The company's Brazilian development team has come out with the Buddy
Cup, a beer glass with an embedded chip. When two Buddy Cups are
clinked together, they automatically send friend requests to the users'
Facebook pages.
"Budweiser loves to share in great times with our fans," said Manuel
Rangel Machiavello of Budweiser Brazil in an email. "The Buddy Cup
brings together the in-bar experience with Facebook, the most used social
media channel for our consumers."
According to Budweiser, users scan a bar code on the bottom of the cup
and provide information from their Facebook profiles so the cup can
connect to their Facebook accounts.
"We did a first pilot event here in Sao Paulo to test the prototype," said
Machiavello. "It was an instant success and we had the chance to register
users' reactions as well. Lots of friends were made that night. Based on
the positive reactions, we are looking at taking this to bigger events in
future."
-- I guess this will give you someone with whom to wonder just what you
did last night. You may even have some photos on Facebook to provide a
clue!
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Special offers
Peter Fitchett
Note: These specials are available to all user group members.
Contact Peter (web@appleusers.co.nz) for access or coupon codes.

TinyLightbulbs, (http://www.tinylightbulbs.com), provides the perfect
home for cool innovations by hosting a diverse community of
independently funded products. TinyLightbulbs is a great gateway for
increasing sales and exposure to targeted customers. They offer these
great products:
Dockem - http://www.tinylightbulbs.com/the-airclip.html
Revolve - http://www.tinylightbulbs.com/revolve-camera-dolly.html
SoundJaw Unlimited
- http://www.tinylightbulbs.com/soundjaw-unlimited.html
Apple user group members throughout the world can receive 20% off
these accessories.
This offer is valid through June 30, 2013.

Que Publishing
Que Publishing has more than 32 years of experience helping users learn
about computers and technology for the home, office, and business.
Their books, eBooks, and videos teach through step-by-step tutorials, are
rich in illustrations, and provide in depth references on important topics
including OS X Mountain Lion, iCloud, Apple devices, and much more.
For those interested in beginner to advanced Mac programming titles,
visit Que’s partner site www.informit.com/store to see new releases
from Addison-Wesley Professional and Sams Publishing.
Apple user group members can take advantage of exclusive product
discounts of 35% off the list price of all print books and 45% off the list
price of all eBooks and Video Training plus free U.S. shipping every day.
This offer is on-going.

Note: These specials are available to all user group members.
Contact Peter (web@appleusers.co.nz) for access or coupon codes.
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iPad tips
The tips mentioned here assume you are running iOS 6.
Shine a Spotlight.
As the number of apps you have installed on your iPad grows, it will
become more difficult to quickly find a desired app when you or your
students need it. Fortunately, the built-in Spotlight search feature can
help. To use Spotlight, click the Home button (or swipe to the right)
while you are on your home screen. As you enter the name of an app in
the search field at the top of the screen, a list of suggestions will appear
below. Tap the name of the desired app once you see it on the list and off
you go. Spotlight can even search your contacts, music, e-mail, and other
information on your device. To determine the information included in
Spotlight searches, go to Settings > General > Spotlight Search.
Everything in its place.
Another way to save time when looking for apps on your iPad is to keep
them organized with folders. Before you can create a folder, you must
first tap and briefly hold on any app to enter a special editing mode
where the apps appear to “shake” or “dance.” Once in this mode, you can
simply drag and drop one app on top of another. iOS will try to guess a
name for the folder, but you can choose a different name as needed. You
can organize apps by task (podcasting, QR code scanning), topic (math,
reading), or intended users (first period, art class). You can have up to 20
apps in a folder on the iPad.
It's all in a gesture.
Multitasking gestures were introduced in iOS 5 and are one of those “set
it and forget it” kind of features. Once you enable these gestures by
going to Settings > General > Multitasking Gestures and tapping the On/
Off switch, you can switch apps by swiping to the left or right with four
fingers. You can also close the current app by pinching in with five
fingers instead of clicking the Home button. Swiping up with four
fingers will reveal the multitasking bar at the bottom of the screen with a
list of recently opened apps. As a bonus, swipe to the right with one
finger on the multitasking bar after performing the four finger swipe up
to reveal “secret” controls for your screen brightness, music playback,
volume, and more.
What does it mean?
If you don’t know the meaning of a word while reading a web page or
ebook, you can easily look it up without having to exit the app or book.
To look up a word with the built-in dictionary, tap and hold on the word,
then select “Define” from the popover menu. Tapping outside the
popover will dismiss the dictionary and allow you to resume reading
where you left off.
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It speaks.
Although it is an accessibility feature intended for people with low
vision, Speak Selection can benefit struggling readers as well. To take
advantage of this feature, you must first enable it in the Settings by going
to General > Accessibility > Speak Selection (under Vision). There you
can adjust the speaking rate (I recommend setting it about a third of the
way in for most students) as well as enable word highlighting. This
option highlights the words as they are spoken aloud, which can be
helpful to readers who tend to lose their place as they read. Once Speak
Selection is enabled, you can use it anywhere you can select text. Simply
tap and hold a word or phrase to reveal handles you can use to make
your selection, then tap Speak from the popover menu to hear the text
read aloud.
Let your thumbs do the work.
The iPad onscreen keyboard can be split to make it easier to type with
just your thumbs when you are holding the iPad with two hands. To split
the onscreen keyboard:
Tap and hold the keyboard key (lower right corner of the keyboard)
and choose the option to split the keyboard (you can also undock it to
move it out of the way if you need to see the bottom of the screen
while the keyboard is visible).
Or, use two fingers and unpinch the keyboard to split it (pinch in to
merge it again).
Mirror, mirror on the wall.
Starting with the iPad 2, you can connect the iPad to a projector or
HDTV and mirror what appears on the device’s screen. You can either
connect the iPad directly to the projector or HDTV using one of the
special adapters available from Apple, or you can mirror the display
wirelessly through an Apple TV. Wireless mirroring requires your iPad to
be on the same Wi-Fi network as your Apple TV. To mirror from your
iPad, double-click the Home button to reveal the multitasking bar, then
swipe to the right with one finger and tap the AirPlay icon (note: this
icon, which will appear to the right of the playback controls, will only be
visible if an Apple TV is available on the same network). Next, select the
Apple TV and tap the On/Off switch for mirroring. If you do not have an
Apple TV, you can still enjoy mirroring through AirPlay by installing an
app such as Reflector, (http://www.reflectorapp.com/), or Air Server,
(http://www.airserver.com/), on your Mac or Windows computer
connected to a projector. These apps even allow you to connect more
than one iPad at a time - if you have a need.
Zoom zoom.
Zoom is another of the built-in accessibility features of iOS. This feature
is intended for users who have low vision, but it can come in handy to
more easily see what is on the screen when you mirror it through AirPlay
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(see above). Zoom is enabled in the Settings by going to General >
Accessibility > Zoom. Once Zoom is enabled, double-tapping with three
fingers will zoom in, and double-tapping a second time with three fingers
will zoom out. You can move around the screen while zoomed in by
dragging with three fingers, and you can adjust the level of magnification
by double-tapping and holding with three fingers, then dragging up or
down.
Score one for the kids.
Guided Access is another accessibility feature introduced in iOS 6. Some
people call it “kid mode” because it allows you to lock the iPad in a
single app before you hand it to a child. As with other accessibility
features, you must first enable Guided Access by going to Settings >
General > Accessibility and choosing Guided Access. There you will also
set up a passcode for exiting Guided Access and returning the iPad to its
normal mode of operation. Once you have it enabled, you can start
Guided Access at any time by opening the desired app and triple-clicking
the Home button. The screen will appear to shrink in and the Guided
Access options will be displayed at the bottom. Before you tap Start, you
can also circle any buttons or other controls you do not want students to
access. These will then be grayed out when you tap Start and the iPad is
in single-app mode. When the iPad is in Guided Access mode, tapping
the Home button will not allow students to close the current app. Only
triple-clicking Home, entering the passcode, and tapping “Done” will
return the iPad to its normal mode. (Don’t forget the password!)
Read(er) all about it.
Although it only works on certain sites (such as blogs and news sites) the
Reader feature of Safari introduced in iOS 5 simplifies the display of a
Web page if you might be easily distracted. You will know a site supports
this feature when a “Reader” icon appears in the address bar. Tapping
this icon will remove ads, navigation bars, and other items that can
distract you from the content of the page. Reader works great with Speak
Selection (see above) to allow you to focus on the text as you hear it read
aloud.
Take it to go.
Reading list is a feature of the Safari browser that allows you to save
web pages so you can finish reading them later when you have more
time. In iOS 6, Reading List can save entire web pages so you can catch
up on your reading even when you are offline.
The latest survey shows that
three out of four people make up
75% of the population.
Artificial intelligence is no match
for natural stupidity.

I think that politicians
should wear uniforms
- like NASCAR drivers so we can identify their
corporate sponsors.
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After life
Fred Showker

What happens to your digital estate and online
holdings when you die?
Have you planned your online estate? They say failing to plan is
planning to fail -- and while nobody wants to talk or think about their
own death, you owe it to the ones left behind to do some serious
planning. For some time, I've investigated the ins and outs of estate
planning for online real estate. My estate planning attorney says treat that
just about like any other property you own. That's the starting point.
Although your digital
estate carries its own set of
rules, it needs careful, Keep your estate accurate estate planning just
like your real-life plans detailed, estate.
accurate, and
All those from the
aging boomer generation are
above all,
now in the phase of
deciding how to prepare
up to date!
their estates for their
eventual demise. Internet
property is very
similar to real, real estate.
Various online accounts have value, and or obligations that will need a
resolution upon your death. Let's get one thing clear up front : you don't
necessarily have to do anything at all. But first ask what you want to
happen.
Online companies, including Google, are coming out with programs and
products to "help" you with your estate. Don't jump into those until
you've read this. Chances are, you don't need any help. If there are
partners, measurable wealth or debt involved, then you will need your
attorney. Additionally, much will depend on your particular state laws
and regulations.
Planning your online estate : first steps:
The first and most important step is easy. If you are the sole owner of
your internet holdings then take an assets inventory. Be be accurate, be
complete. Assume the person reading this after your passing will know
nothing about the web.
The Estate Inventory:
• Specifically list each and every web entity you own
• Briefly describe each entity, it's purpose, and how it works
• Specifically list the provider for each entity.
• Provide exact URL, FTP and login or cPanel addresses for each
• Provide exact expiration dates for each
• Provide accurate IDs and passwords where required
Along with a complete and detailed listing, you also should provide
contact info for any service providers, programmers or web subcontractors who have worked with your holdings. This can be very
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important. Remember, someone will have to close those accounts or
move them into an 'estate' account, log in and delete content, close web
sites or pages or blogs and so forth. Be accurate. Be specific.
Next step : Designate who will handle your online affairs
Next, you need someone who will take care of this for you -- someone
you can trust, and someone who has your best interest in mind. That
person will be obligated to take the role, so, call them and discuss this
role with them. A spouse, family members or friends will usually accept
the challenge, and consider it an honor.
Your executor can be different from the executor of your real-world
estate, but it is very important that this person be aware of the
responsibilities of your bequest. You could also assign your real-world
executor with the option to hire a "guru" to help through the process. You
can also assign your attorney or law firm, or even a bank to handle this
for you. They will be happy to discuss this with you -- and most likely,
they'll take a fee from your estate for this service.
Rule of thumb: the more complicated the digital estate, the more
competent your executor should be.
Last but not least : The Bequest
With your inventory and your executor you now add the third and final
element : the bequest. Simply put, the bequest is a short, clear document
stating how you want your digital life resolved. Who will do it, and what
will be done.
I have followed the lead set forth by my estate attorney: a recently
updated digital "will" is printed and provided to my attorney as part of
my will. It describes all the properties in detail, but not the id, logins,
passwords, etc. It instructs my executor to "find" the most recent and
final copy of the requests on my computer under a specific file name.
This way, some detail that may change repeatedly, like passwords, can be
updated regularly without affecting the recorded will.
What you do with your digital estate is your call. You can give it to
anyone you desire, or you can merely request it be shut down and
deleted. You can let your domains go dark, and expire. If the Design
Center is not sold, or taken over for continuation, I am providing renewal
payment for my domains because I don't want them falling into the hands
of domainers, spammers or other cybercrooks. If there is a known value
to the entity, you can specify it be "sold" and proceeds added to your
financial estate. If you've had friends or contacts who would benefit from
the properties, you can name those benefactors.
In the case of PayPal or other 'financial' accounts that may have funds in
them, you treat those just like a real-world account. Cash them out, and
put the funds in an 'estate' account, close the Paypal, and add it as a line
item to your estate chart of accounts. In most online accounts such as
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Paypal, you can export the entire history in various formats -- even
Excel.
The final step: Make it legal
Take your letter to a public notary, along with one witness -- all three
sign, and the notary stamps the seal -- now it is a legal document. You
can also do this at your attorney's office, if you have an estate planning
attorney.
Keep it current:
Each time you change something, amend your documents. Make sure
that this document continues to be part of your will and estate planning
packages. It can be as simple as a letter to your attorney, a sealed letter in
a safe deposit box, or a trusted family member who will survive you. Ask
your counsel for specific procedures and advice.
What about a "Social Media Will"
Social media is a bit different. You don't own that. So, in all your
documentation, list your various Facebook, Twitter and other accounts,
ID, Passwords, etc. Next, make very clear requests of what should be
posted on the front pages, and how/when to shut it down and delete all
the data. You may wish to just leave it. Generally that's okay if it's really
what you want. But be assured, people will find it and look at it again
and again into the future. At the very least, some announcement needs to
be posted so people know.
Although I'm not really sure how I feel about letting Google into my
personal life, they have recently added a feature that lets you decide what
happens when you no longer use your account. It's called Inactive
Account Manager and the goal was to offer a feature that tells Google
"what you want done with your digital assets when you die or can no
longer use your account". But if you trust Google, then this may be the
way to go. Read about Google's “plan for your digital afterlife”, and
using Google's “Inactive Account Manager”. But remember that if you
have properties other than Google+, Google, YouTube, Picasa or
Blogger, then you'll need the other elements discussed above anyway.
What about my computer?
Again, a personal preference. Specify the demise of your computer's
content in your document. There are many options -- wipe it and sell it,
gift to someone, or be resolved as another piece of furniture in your
estate. But take care to designate what happens to the content -- the data
on the hard drive. There may be things on there you don't want anyone to
have. Make your wishes very clear.
We're seeing a lot of companies coming out with programs and products
to "help" you with your digital, online estate planning. It's your choice to
use these or not. The above is a good, wrap-around overview that you
can probably do yourself, everyone has different wishes and needs, so
take advice if you are in doubt.
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Mac 911
Christopher Breen
Calendars
Is there is a way to get the holidays to show up in Calendar (on Mac and/
or iPhone). It would be nice to know these things when I look at the
calendar.
There is. By default Calendar doesn’t come equipped with a holiday
calendar, but it’s easy to add one through calendar subscriptions. The
manual way to do this is to cruise the Internet until you locate the kind of
calendar you seek, copy the URL for that calendar, choose File New
Calendar Subscription, and in the sheet that appears enter the copied
URL and click Subscribe.
For example, if I wanted to add the San Francisco Giants 2013 baseball
schedule to Calendar (and who wouldn’t?) I’d enter this URL:
http://mlb.mlb.com/soa/ical/schedule.ics?team_id=137&season=2013.
When I click Subscribe I see the calendar name along with its chosen
color (you can choose a different one if you like). I can then choose
where to add that calendar—on my Mac or to iCloud, for instance. I can
additionally choose to remove alerts and attachments and choose how
often I want the calendar to refresh—your choices are every five minutes,
every fifteen minutes, every hour, every day, and every week. For this
specific calendar you’ll want it to refresh every day as the calendar is
updated to include the previous days’ scores.
Because you want this calendar synced to your iPhone as well, you
should choose to add it to iCloud. It, along with all your other calendars,
will then be synced to your iOS devices.
I’ve shown you the manual way, but you should have to do this only on
rare occasions. And this is because there are lots of websites that offer
direct calendar download links. For instance, if you want to add U.S.
holidays to Calendar, just travel to Apple’s US Holiday Calendar page.
When you click on the Download link the calendar will download,
Calendar will launch, and you’ll be prompted to configure the calendar.
At one time there were sites devoted entirely to providing downloadable
calendars but they’re no longer being kept up to date. Instead, turn to
your favorite search engine and query “download calendar nameofthing”
where nameofthing is the schedule or calendar you want to download.
What you seek are calendars in the iCalendar format (files in this format
end with .ics). This is a calendars standard that can be read by nearly all
calendar clients.
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Google Hangout and the uncooperative camcorder
I have a FireWire DV camcorder that works great with some video
applications, but I can’t make it work with Google Hangout. Any ideas?
After reading your question I gave the setup a try with my Sony DV
camcorder, and you’re right. Google Hangout tells me that no such
camera is connected even though Skype and Messages sees it. Given
that, I’ll lay the blame at the feet of the plug-in necessary to use video in
a Google Hangout.
Thankfully there is a free workaround—ManyCam. Designed primarily
so that you can use your webcam with multiple applications at the same
time, when you install ManyCam you’ll find that Google Hangout also
now recognizes your attached DV camcorder.
ManyCam’s talents don’t end there. With it you can add a variety of
effects, green-screen-like backgrounds, face accessories (silly eyebrow,
eyeglasses, faces, hair, and hats), type text over your image, place a
clock in the picture, and draw over the picture as it’s projected.
I’ve found that video produced by ManyCam to be not as smooth as the
native video offered in Skype or Messages, but it’s not terrible. If your
Mac doesn’t have a built-in FaceTime/iSight camera or you just want the
power of a camcorder’s optical zoom, it’s a setup that’s worth your
while.
The mysterious address-less Address Panel
I want to use Calendar's Address Panel to add invitees but when I open
it, it doesn't show me my contacts. What's happening?
Yep, Address Panel is confounding. You're frankly better off choosing
Window > Contacts and inviting people by dragging contacts from the
Contacts application to the Invitees field. But here's what's happening.
The addresses stored in Contacts will appear in the Address Panel
window only if you've created a local calendar (and chosen that calendar
for your event). What helps make this confusing is that if you've created
an iCloud account, launched Calendar, and then choose File > New
Calendar, you'll discover that your only option is to create an iCloud
calendar. This makes sense in a world where we want to sync our events
across computers and devices. But what if you don't want to?
In order to create a local calendar, choose Calendar > Preferences and
then select the Accounts tab. Now choose your iCloud account and
uncheck Enable This Account. (If you have other accounts that sync
events such as a Google or Yahoo account, you'll need to disable them as
well.) Once you've accomplished this, choose File > New Calendar
again. This time you'll see no submenu. When you invoke the command
a new On My Mac entry will appear in the calendar list and a calendar
will appear below it.
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You can now reenable the accounts you disabled. Once you've gone
through this process you can then create new local calendars as well as
calendars associated with iCloud or other calendar services.
"Great!" you say. "Now I can use Address Panel to drag contacts to any
calendar I create!"
To which I reply:
"Not so fast, buster."
Choose any calendar other than a local one and your contacts disappear
from Address Panel. And they do because when you choose a calendar
synced to a server--an iCloud, Google, or Yahoo calendar, for example-Calendar wants to see an LDAP (Lightweight Directory Access Protocol)
server on the other end. This is a server-based directory of addresses
you're granted access to. Once connected to that server, you can search
for a name and, if it's in the directory, it will appear among the results.
The problem is that the contacts you've synced with iCloud and Google
aren't accessible in this way within the Calendar application. They
should be if you're using Exchange, however--as you might for your
company email.
Which brings me back to "You're frankly better off..." because, for the
vast majority of us not using Calendar for enterprise scheduling, this
window is entirely useless.
Macworld Senior Editor Christopher Breen is the author of "Secrets of
the iPod and iTunes (6th edition)," and "The iPod and iTunes Pocket
Guide (4th edition)" both from Peachpit Press.

iMumble 38.0
iPower
Are you planning to iNvest iN Mighty River Power?

Barry Clark

I have to ask the question, "Why?" because we own it already. iN fact we
have probably paid for it time and time again, and it looks as though
we're about to pay for it again.
There is a list of things that should remain in the ownership of the people:
energy, education, transportation, the military (and Police),
communications, banks ...
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Book Review: Master your Mac
Dave Greenbaum

Master your mac
2nd Edition
Over 400 Tips, Tricks, Hints, and Hacks for
Apple OS X
By Keir Thomas
Pages: 424
Very few intermediate books truly exists but this
is the "just right" level for an experienced Mac
user who wants to take his or her experience to
the next level without learning programming or
spending hours at a command prompt.
This book is in a "cookbook" style with various recipes you can try,
divided up into sections such as automation, productivity and security.
Each recipe includes a justification for the project and tells you the very
basics of how to do it to help the reader reach that intermediate level.
After establishing the basics, Cone suggests configurations and software
to take it to the next level. The built-in functions of Spotlight are great,
but programs such as Alfred build on that skill set and make your Mac
usage experience extraordinary.
I was initially skeptical, but pleasantly surprised by this book. I expected
a series of simple tips and tricks I already knew or topics so advanced
and complex that it simply wasn't worth my time "trying" these ideas.
The book has a perfect balance of suggestions and project that can really
enhance your Mac. Sure, I could research programs in the App store or
online but this book curates all those thousands of programs into a series
of basic ideas and solving of problems. Use an external monitor? An
entire chapter covers things you can do to prevent annoyances such as
knowing where your menu bar is or the annoying resizing of windows
when you disconnect your monitor.
Experienced Mac users will benefit most from this book, but even
beginners who simply want more will find a great series of ideas in this
book. These chapters solve problems intermediate users experience and
beginners haven't quite hit the wall yet.
One of the best books on the Mac I've read in recent years and makes a
great gift for any Mac user that wants to be more productive and efficient
without investing too much time or energy.
Pros: Outstanding series of ways to use your Mac better with detailed
instruction
Cons: The book quickly needs a version 2 because I finished the book
wanting more of the same.
Five out of Five Dogcows
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Book Review: Mac Kung Fu
Dave Greenbaum

Mac Kung Fu
Simple Ways to Tweak, Customize, and Secure OS X
By Matt Cone
Pages: 424
While the Mac is generally perfect as is with
its intuitive interface and easy to understand
menus and help screens, a group of Mac
users simply want more out of their systems.
They know the Mac can do more, but can’t
quite figure out what they need. Similarly,
the Mac has annoyances and quirks a user
has learned to live with, but might like the Mac even more if they could
only change some aspect of how it works. This book is for that group!
The ideal audience of this book is an intermediate Mac user who isn't
afraid of making changes to program settings or going into terminal and
typing a command or two. Knowledge of UNIX or programming isn’t
required, just an adventuresome attitude and a willingness to learn.
Most of the tips were commands and functions I never knew existed and
wasn’t looking for them but now that I’ve found them I couldn’t imagine
life without them. For example, a simple terminal command will turn off
that annoying question about using TIme Machine on a new hard drive
when it’s plugged in. Another amazing tip is being able to show the full
pathnames of file locations in the title bar. Saves me the confusion of
knowing which disk is the original and which is the copy.
Probably all of these commands, tips, and tricks can be found online
somewhere but Kung Fu puts it all together from a reliable source so you
can take your Mac skills to the next level.
Pros: Amazing tips and tricks
Cons: No blackbelt issued at the end

Both reviews were originally published and written for the Lawrence
Apple Users' Group 2.0 http://www.laugks.org/news and published by
Dave Greenbaum at http://www.clickheretech.com
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Slow Internet
Do you measure the web-page load time with a clock or a calendar? A
great many factors make one page faster than another. And a great many
other factors can make the same page fast one day (or hour) and slow the
next. Most of these variables are completely out of your control. But
what are they?
First, there's the page itself. Pictures take more time to download than
text, and large pictures take more time than small ones. And some web
developers might use a large image and tell your browser to resize it
smaller - so you can’t tell by just looking at the page (and the large
image still needs to be downloaded so that your browser can make it
smaller!)
A well-written page--and I'm talking about code, not text--will take less
time to load than a poorly-written one.
And then there's the server. That Web page exists on some computer--a
server--somewhere on the Internet. How fast is that server? And how
many other pages is it sending out to other people at the same time? Your
computer slows down when you're running too many programs. So does
a server.
What's more, the Web page probably didn't exist on the server before you
requested it. Most pages on the Web are created by a database query. The
query speed is another potential bottleneck, especially if you have a slow
or overloaded server.
Remember when you got your internet connection - it had this big
number for the down-load speed, but a much smaller one for the up-load
speed (you don’t do much of that, do you?). Well the server is doing the
up-load stuff, so “hopefully” it doesn’t have a hobbled internet
connection!
Then the page has to get from that server to you. To do that, it goes
through several additional servers, and the cables connecting them. Any
one of these could be overloaded or in poor condition.
What can you do about it? Not much. If most pages download quickly,
improving your own Internet connection is unlikely to help the slow
ones.
Different browsers may make a small difference - they are all optimised
slightly differently. And if your browser has been running for a long
time, it may be getting buried in accumulated garbage - try restarting it.
But there's one other thing you can do. If a page seems to be taking
forever, cancel it and try again. And if that fails, try again in an hour.
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Dictionary Tips
Use pop-up definitions
A useful, and chronically underused,
OS X feature is systemwide pop-up
definitions. In most Mac
applications—including Safari,
Mail, Pages, TextEdit, Twitter, you
name it—just position your cursor
over the word you want to define
and press Command-Control-D. A pop-up window appears containing
the definition, synonyms, and any relevant Wikipedia entry.
Click the header for Dictionary, Thesaurus, Apple, or Wikipedia to open
Dictionary to the relevant page.
Use contextual menus
Say you’ve forgotten the Command-Control-D shortcut already. Are you
out of luck? Of course not. In most applications, you can instead select a
word and Control-click (or right-click). A contextual menu appears.
Select Look Up in Dictionary (or Look Up) and the definition appears.
Use Spotlight
Another quick way to look up a word is by using the Spotlight search
menu. Press Command-spacebar to activate it, and then type in the word
you need defined. One of your results will be ‘Look Up’ next to the
Dictionary icon. You don’t have to select this and press Return. Instead,
simply hover your cursor over the entry and a pop-up menu will appear
with the full definition. If you don’t want to reach for your mouse, press
Command-L to jump immediately to the definition.
For more options—like the ability to look for synonyms—select the
Dictionary entry (or press Command-D), and the Dictionary application
will open to your word.
Make Dictionary talk
Perhaps your elementary school teachers taught you how to decipher the
pronunciation symbols provided by the dictionary, but…perhaps not. Did
you know that you can get Dictionary to pronounce words for you?
Go to System Preferences, click Dictation & Speech, click the Text to
Speech tab, and choose a voice.
To make Dictionary talk, select a word and Control-click (or right-click)
it. From the contextual menu, choose Speech > Start Speaking.
If the word isn’t split into syllables (say, down below in its Thesaurus
entry), you don’t even have to select it. Just point to it with your cursor
and Control-click.
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Change your sources
Dictionary comes with a bunch of built-in reference sources. Select
Dictionary > Preferences to see the list. Here you can determine which
sources will show up when you search and what order they’ll show up in.
So, for instance, you could get rid of Wikipedia, add a Spanish language
dictionary, or switch out the American English dictionary for a British
English one.
Note that you have to be connected to the Internet to access Wikipedia.
And what’s the Apple dictionary, you may ask? It includes a glossary of
Apple terms—helpful for those times when you’re not interested in the
type of apple you can eat.

Thomas Cook Holidays
It’s lazy of the local shopkeepers to close in the afternoons. I often
needed to buy things during ‘siesta’ time -- this should be banned.
We booked an excursion to a water park but no-one told us we had to
bring our swimming costumes and towels.
Topless sunbathing on the beach should be banned. The holiday was
ruined as my husband spent all day looking at other women.
No-one told us there would be fish in the sea. The children were startled.
We went on holiday to Spain and had a problem with the taxi drivers as
they were Spanish.
It took us nine hours to fly home from Jamaica to England. It took the
Americans only three hours to get home.
There was no egg-slicer in the apartment.

SeniorNet Mac
Computer Training Lessons: Two-hour sessions, once a week for four
weeks. Course notes are provided. Classes are small with a maximum of
six students and two tutors per lesson.
Social Events: Held on the fourth Tuesday of the month.
Newsletter: Supplied every two months.
We are now located at: 190 Worcester Str, Christchurch.
Contact: If you would like to join SeniorNet Mac and are in the 55-plus
age group, please contact Allan Rutherford at (03) 352-4950, or email:
ajmr@xtra.co.nz,
or else leave a message on the club’s answerphone at (03) 365 2003.
page 22 Applebyte

I think it should be explained in the brochure that the local shops in
Indian villages don’t sell proper biscuits like custard creams or ginger
nuts.
I was bitten by a mosquito. No-one said they could bite.
I compared the size of our one-bedroom apartment to our friends’ threebedroom apartment and ours was significantly smaller.
The brochure says “No hairdressers at the accommodation”. We’re
trainee hairdressers -- will we be OK staying there?
The roads were uneven. [Must have been Christchurch! - Ed.]
There are too many Spanish people. The receptionist speaks Spanish.
The food is Spanish. Too many foreigners now live abroad.
It is your duty as a tour operator to advise us of noisy or unruly guests
before we travel.
We had to queue outside with no air-conditioning.
My fiancé and I booked a twin bedded room, but we were placed in a
double bedded room. We now hold you responsible for the fact that I find
myself pregnant. This would not have happened if you had put us in the
room that we had booked.
~~ ~~ ~~
On a cold winter’s morning, wife texted husband:
Windows frozen, wont open
Husband texts back:
Gently pour some lukewarm water over it
Five minutes later wife replies:
Computer really mucked up now

AUGC contacts
Website

http://www.appleusers.co.nz

Mailing Lists

Peter Fitchett
listadmin@appleusers.co.nz

(3) 960 8189

The AUGC Discussion List is for members who
wish to discuss club matters.
The HELP list is open to all Mac users who wish to
give or receive assistance.
Membership

treasurer@appleusers.co.nz
with printed Applebyte:
$45 per annum
without printed Applebyte
$25 per annum
($5 discount for early renewal)
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About the user group
Aims

The Apple User Group of Canterbury
Incorporated (AUGC) is a non-profit
organisation which exists for the purpose
of exchanging ideas and expertise about
the use of Apple computers, the
Macintosh operating systems, and related
hardware and software.

Committee
Patron
President

Noel Strack
president@appleusers.co.nz

Vice-President
Secretary
Treasurer
Committee

Help:

vicepres@appleusers.co.nz
Jim Pollard
secretary@appleusers.co.nz
Eion McIntosh
treasurer@appleusers.co.nz
Belinda Carter
b.carter@paradise.net.nz
Peter Fitchett
editor@appleusers.co.nz

(3) 355 4546

(3) 358 7943
(3) 383 0812
(3) 942 3000
(3) 960 8189

A full list of helpers and volunteers can be
viewed in the Contacts section of our website.

Snail Mail: PO Box 31–053, Christchurch, New Zealand.
Website: http://www.appleusers.co.nz

